TODAY'S CLASS

Part 1: Working in a Reproducible Environment:
d R Projects, R Markdown, R Notebooks
d Creating and editing R Markdown files

Part 2: Importing Data with Base R and the Tidyverse

Part 3: Coding Exercises (importing data to begin your midterm
project)



WORKING IN A REPRODUCIBLE
ENVIRONMEN T




"Organization is what you do before you do something, so that
when you do it, it is not all mixed up.”

- A. A. Milne



THE BASIC IDEA

R project ?

R Markdown ?

R Notebook ?




THE BASIC IDEA

Topic Description

R project Convemently organizes files pertaining to specific analytic
Drojects
Allows user to combine prose, code, and metadata into one
R Markdown . . o . .
file to increase reproducibility and reporting capabilities
An R Markdown document that allows for independent and
R Notebook . . . .
iNnteractive execution of code chunks. Great for sharing.

All 3 have the goal of streamlining your workflow!



RS TUDIO PROJECTS



USING PROJECTS

RStudio projects make it straightforward to divide your work
iINnto multiple contexts, each with their own:

e WOrking directory
e WOrkspace

e NIStory

e SOUrce documents



File > New Project

e oLt
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O WHAT'S DIFFERENT?
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SO WHAT'S DIFFERENT?

VWhen a project Is opened:

« A new R session Is started

« [he .Rprofile file in the project's main directory Is sourced

o ho DMNAtA fila in ths mravinct'e mman Airactarnys 1 InaAaAd
MC—INData T trric Porojctct S rran O CTtory 1o TgatutTu

« [he .Rhistory file In the project's main directory Is loaded

« [he current working directory is set to the project directory

« Previously edited source docs are restored to the editor tab

« Other RStudio settings (active tabs, splitter positions, etc) are restored

We can also work with multiple projects at one time



ot [ PROJECT OPTIONS

Tools » Project Options

Project Options
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R MARKDOWN



WHAT IS MARKDOWN?

e A markup language used to format
plain text

e Used by

Facebook chat
Reddit

Skype

R

Python

And MANY others!

whats-markdown.md

Markdown 1s a lightweight markup language that you can use to add formatting
elements to plaintext text documents. Created by [John Gruber|(https://
daringfireball.net/projects/markdown/) in 2004, Markdown is now one of the
world's most popular markup languages.

Using Markdown is different than using a [WYSIWYG](https://en.wikipedia.orc
wiki/WYSIWYG) editor. In an application like Microsoft Word, you click buttons
to format words and phrases, and the changes are visible immediately. Markdown
isn't like that. When you create a Markdown-formatted file, you add Markdown
syntax to the text to indicate which words and phrases should look different.




USING R MARKDOWN

R Markdown, a file format that leverages Markdown, allows you to
turn your analyses into high quality documents, reports

presentations, and dashboards
e HTML N
» POF o
e Lalex 2z
e ePUB

e ElcC.



HOW DOES |'T WORKY

1. Type text and code here 3. Get your report

knitr

2. Push this button




WHAT DO R MARKDOWN FILES LOOK

R
ty

=

Md (R Markdowr

LIKE?
es) -

output: html document

ically contains three

~ o

-_r]||ﬁ1§;55° This is an R Markdown document. Markdown is a simple formatting syntax for authoring HTML, PDF, and MS Wor

d documents. For more details on using R Markdown see .

When you click the **Knit** button a document will be generated that includes both content as well as the

<O pthna‘) YAM L output of any embeg®ed R code chunks within the document. You can embed an R code chunk like this:
header -~ gr)

summary (c
Chunks of R cod /

EE can also embed plots, for example:

"' Ir, echo=FALSE}
plot(cars)

Text mixed with
Sl m p‘e -_O rmettl qg, Note that the "echo = FALSE™ parameter was added to the code chunk to prevent printing of the R code that

leveraging Markdown

generated the plot.




Run indivic

RUNNING CODE CHUNKS AND
ENTIRE R MARKDOWN FILES

ual code

chunks with the gree
run 1con

‘epo
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Produce a comp\ete
Dy pressing the

ing” a document
s to execute all
code chunks ana

produce a markdown
document
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kitle: 'k

B v K v 3 Insert ~ = Run ~

1tled”

attiref._"John Jacob JingleHeimer Schmidt"

adte: "10

C) M "
(J O >

output: html_document

"“{r setup, include=FALSE}
knitr: :opts_chunk$set(echo = TRUE)

## R Markdown

This 1s an R Markdown document. Markdown 1s a simple

formatting syntax for authoring HTML, PDF, and MS Word

documents.

For more details on using R Markdown see

<http://rmarkdown.rstudio.com>.




[et's Practice!

You'll need three files open for this activity.

» Create a new .Rmd file: RMarkdown Demonstration Report.Rmd
» Open from today’'s Week 2 folder that you downloaded:
e RMarkdown Demonstration Text.docx

e RMarkdown Demonstration Code.R



R MARKDOWN CHEAT SHEET!

e RStudio creates cheat sheets to help
you remember everything!

e [he R Markdown cheat sheet will help
vou today!

e [0 fING
can:

J Google |
Jd In RStudio, go to Help—2>Cheatsheets

RStudio’s cheat sheets, you

-
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HOW 10O: FORMAT PLAIN TEXT

Place one asterisk or one # italicize a word/phrase
Underscore on each side of a *italic*
word/phrase to italicize it _this phrase is in italics_

Place two asterisks or two

underscores on each side of a # bold a word

‘ o ! *
V\/Qrd/phrage to bold it Ez?/dl m bold and awesome

Place backticks around an R
command to create inline code

# inline code chunks with backticks

(OI” around a. word to ‘package name # this appears in monospaced font
MONoOspace IJE) ‘nrow(iris)” # this will show a number after knitting
-nd a word/phrase with 27

for superscript or ~2~ for # superscript and subscript

S| bSCI’ipt superscript2.

subscript™~2~



HOW [O: FORMAT HEADERS

The number of # signs dictate how large the header Is

# Hl1
## H2
#E H3 H2
##E# H4
#HE#FE HS H3
#HEFHAF HO

H4
Alternatively, for H1 and H2, an underline-ish style: H5
Alt-H1 e
====== Alternatively, for H1 and H2, an underline-ish style:
Alt-H2 Alt-H1

Alt-H2



HOW TO: LINKS AND IMAGES

# show a URL as a hyperlink
<http://whatacoolexample.com>

# show a hyperlink with a linked phrase
[OMG this text will show instead of the URL](http://whatacoolexample.com)

# caption for a picture
I[cute dog pic](/file/location/cutedogpic.png)



YOUR TURN!

From the Word document, copy all text beginning Data
with # Data and eﬂdlﬂg with "...2006 ASA Data EXIQO The atmos data set resides in the nasaweather package of the R programming language.
aNndad pagte the text |nto yOU a Rmd f”e It contains a collection of atmospheric varnables measured between 1995 and 2000 on a grid

of 576 coordinates in the western hemisphere. The data set comes from the 2006 ASA Data
Expo.

1. Turn the line that begins with "Data" into a
second level header.

2. Change the words atmos and nasaweather Into a
monospaced font suitable for code snippets.

3. Make the letter R italicized.

4. Change "2006 ASA Data Expo" to a link that
points to http://stat-
computing.org/dataexpo/2006




SOLUTION

1. Turn the line that begins with "Data’ Data

The atmos data set resides in the nasaweather package of the A programming language.

i n tO a S e C O r] d ‘ e\/e ‘ h e a d e I" It contains a collection of atmospheric vanables measured between 1995 and 2000 on a grid

of 576 coordinates in the western hemisphere. The data set comes from the 2006 ASA Data
Expo.

#H# Data



SOLUTION

2. Change the words atmos and Data

The atmos data set resides in the nasaweather package of the A programming language.

Nd Sa\/\/eath i | r] tO a m O n O S :) a Ce d ]CO nt It contains a collection of atmospheric variables measured between 1995 and 2000 on a grid

of 576 coordinates in the western hemisphere. The data set comes from the 2006 ASA Data

suitable for code snippets. o

The atmos data set resides in the
‘nasaweather package



SOLUTION

3. Make the letter R italicized. Data

The atmos data set resides in the nasaweather package of the R programming language.
It contains a collection of atmospheric variables measured between 1895 and 2000 on a grid

of 576 coordinates in the western hemisphere. The data set comes from the 2006 ASA Data
Expo.




SOLUTION

4. Change "2006 ASA Data Expo" to a link DPata

The atmos data set resides in the nasaweather package of the A programming language.

th at p O | ﬂ tS tO h t-_ E 2 ) //Sta t — It contains a collection of atmospheric variables measured between 1595 and 2000 on a grid

of 576 coordinates in the western hemisphere. The data set comes from the 2006 ASA Data

computing.org/dataexpo/2006 i

The data set comes from the [2006 ASA
Data Expo](http://stat-

computing.org/dataexpo/2006).


http://stat-computing.org/dataexpo/2006

HOW TO: LISTS

# numbered lists (don’t forget the space after the dot)

1. One
2. Two
3. Three

# bulleted list with sub points (two spaces in front for sub points)
# can use *, -, or + symbol for bullet points
* eggs
* milk
- skim
- full fat

* bread
* (chocolate to eat on way home so bae doesn’t eat it)

# can mix types
1. it’s
2.3
+ hi
+ there
3. mixed list



YOUR TURN!

5. Turn the text into a bulleted list with 3 Pata

The atmos data set resides in the nasaweather package of the R programming language. It

b U ‘ ‘ etS te m p ’ p re S S U re ’ OZO n e . contains a collection of atmospheric variables measured between 1985 and 2000 on a grid of

576 coordinates in the western hemisphere. The data set comes from the 2006 ASA Data Expo.

Some of the variables in the atmos data set are:

é . M a ke te m p : p re SS U re 7 OZO n e bo | d at « temp - The mean monthly air temperature near the surface of the Earth (measured in

degrees kelvin (K))

th e Sta rt O]C e a C h e n t I"y . « pressure - The mean monthly air pressure at the surface of the Earth (measured in

millibars (mb))

 pzone - The mean monthly abundance of atmospheric ozone (measured in Dobson units

/. Make K, mb, and DU italicized at the o
end of each entry.




SOLUTION

5. Turn the text into a bulleted list with 3
bullets: temp, pressure, ozone.

*temp —
* pressure —

* ozone —

Data

The atmos data set resides in the nasaweather package of the R programming language. It
contains a collection of atmospheric variables measured between 1995 and 2000 on a grid of
576 coordinates in the western hemisphere. The data set comes from the 2006 ASA Data Expo.

Some of the variables in the atmos data set are:

« temp - The mean monthly air temperature near the surface of the Earth (measured in
degrees kelvin (K))

« pressure - The mean monthly air pressure at the surface of the Earth (measured in
millibars (mb))

« pzone - The mean monthly abundance of atmospheric ozone I:I"I"IEEEUFEﬂ in Dobson units

(DU))



SOLUTION

é . M a ke te m p’ p reSS U re’ OZO n e b0|d at E‘leaa.tl,:mau.s data set resides in the nasaweather package of the R programming language. It

th e Sta I,-JE O]C e a C h e n t I,- contains a collection of atmospheric variables measured between 1995 and 2000 on a grid of
y o 576 coordinates in the western hemisphere. The data set comes from the 2006 ASA Data Expo.
Some of the variables in the atmos data set are:

« temp - The mean monthly air temperature near the surface of the Earth (measured in
degrees kelvin (K))

« pressure - The mean monthly air pressure at the surface of the Earth (measured in

b 3 **temp** _ millibars (mb))

« pzone - The mean monthly abundance of atmospheric ozone I:I"I"IEEEUFEﬂ in Dobson units

(DU))
* **¥pressure™®* -

X **OZOne** _



OLUTION

/. Make K, mb, and DU Italicized at the
end of each entry.

*K*
*mb*

Data

The atmos data set resides in the nasaweather package of the R programming language. It
contains a collection of atmospheric variables measured between 1995 and 2000 on a grid of
576 coordinates in the western hemisphere. The data set comes from the 2006 ASA Data Expo.

Some of the variables in the atmos data set are:

« temp - The mean monthly air temperature near the surface of the Earth (measured in
degrees kelvin (K))

« pressure - The mean monthly air pressure at the surface of the Earth (measured in
millibars (mb))

« pzone - The mean monthly abundance of atmospheric ozone I:I"I"IEEEUFEﬂ in Dobson units

(DU))



Multiple markdown syntaxes

ex|s
and

(cent

to disple
ered or

own line)

HOW 10O: FORMULAS

C to place Inlir

v O

page on

LaTeX formulae:

O S
O

Urround

ne $ sigr

N

O Surrourd
two $ s
formula

f

gr

r

rorme
S LO C

e fo

‘mulas

T“,‘c

formula with
LO create an
ine formula

S

ItS

th

ay a

# create inline formula
S\forall x \in X, \quad \exists y \leg \epsilonS

# create displayed formula

SS\cos (2\theta)

= \cos”2 \theta - \sin*2 \thetaS$



YOUR TURN!

8. Create a function that illustrates the

conversion from Kelvin to degrees
Celsius:

celsius = kelvin - 2/3.15

Data

The atmos data set resides in the nasaweather package of the R programming language. It
contains a collection of atmospheric variables measured between 1895 and 2000 on a grid of
276 coordinates in the western hemisphere. The data set comes from the 2006 ASA Data Expo.

Some of the variables in the atmos data set are:

« temp - The mean monthly air temperature near the surface of the Earth (measured in
degrees kelvin (K))

« pressure - The mean monthly air pressure at the surface of the Earth (measured in
millibars (mb))

« ozone - The mean monthly abundance of atmospheric ozone (measured in Dobson units

(DU))

You can convert the temperature unit from Kelvin to Celsius with the formula

celsius = kelvin — 273.15

And you can convert the result to Fahrenheit with the formula

fahrenheit = celsius x g + 32



SOLUTION

8. Create a function that illustrates the Data

The atmos data set resides in the nasaweather package of the R programming language. It

C O r] \/e rS | O n ]Cro m Ke ‘ \/l n tO d eg re e S contains a collection of atmospheric variables measured between 1995 and 2000 on a grid of

576 coordinates in the western hemisphere. The data set comes from the 2006 ASA Data Expo.

C e | S | US: Some of the variables in the atmos data set are:

« temp - The mean monthly air temperature near the surface of the Earth (measured in
degrees kelvin (K))

« pressure - The mean monthly air pressure at the surface of the Earth (measured in
millibars (mb))

« ozone - The mean monthly abundance of atmospheric ozone (measured in Dobson units

celsius = kelvin - 2/3.15 eu

You can convert the temperature unit from Kelvin to Celsius with the formula

celsius = kelvin — 273.15

And you can convert the result to Fahrenheit with the formula

fahrenheit = celsius x g + 32

SScelsius = kelvin - 273.155S



HOW TO: WHAT IS A CODE CHUNK?

e A code chunk runs code (this is a # code chunk example

. : , T .
Mmarkdownr prmmp‘e in general, ﬂOtJUSt for ft\\\é\r/}hatwﬂlthls code chunk do:

R Markdovvn) summary(cars)

e Necessary to run code in an R Markdown
-Ci e

e [hree ways to insert code chunk:

v Keyboard shortcut! Ctrl + Alt + |

v “Insert” button in the toolbar

v Manually typing "~ "{r}



HOW [0O: CODE CHUNK NAMES

e (Can give code chunk an optional name # code chunk example
. # What will this code chunk do?
e Advantages of naming code chunks: “{r cars-summary}

summary(cars)

o Navigate to specific code chunks easily
with the drop-down code navigator I
the bottom-left of the script editor

o Graphs made from chunks will be
easier to use elsewhere

o Can cache chunks to knitting time later

e Place code chunk name inside {} after the
etter r




HOW 10O: CODE CHUNK OPTIONS

o Customize code chunks with options  # code chunk example with option
that are placed in the chunk header  #what will this code chunk option do?

. ~{r cars-summary, echo = FALSE, warning = FALSE}
e [here are over 60 options! The summary(cars)

most important options are below.

Option Run code show code QOutput Plots Messages Warnings
eval = FALSE
include = FALSE
echo = FALSE
results = "hide"
fig.show = "hide"
message = FALSE

warning = FALSE



YOUR TURN!

9. Add code chunk 1 (R packages) Data

The atmos data set resides In the nasaweather package of the A programming language. It
contains a collection of atmospheric variables measured between 1995 and 2000 on a grid of
276 coordinates in the western hemisphere. The data set comes from the 2006 ASA Data Expo.

° SEt message:FALSE SO megsages are Some of the variables in the atmos data set are:
nOt prOduced |n yOur repOrt When « temp - The mean monthly air temperature near the surface of the Earth (measured in

degrees kelvin (K))

yO U ‘ O a d th e p a C ka ge S « pressure - The mean monthly air pressure at the surface of the Earth (measured In

millibars (mb))

« pzone - The mean monthly abundance of atmospheric ozone (measured in Dobson units

10. Add code chunk 2 (year being o0

You can convert the temperature unit from Kelvin to Celsius with the formula
anal VZ€ a ) celsius = kelvin — 273.15

And you can convert the result to Fahrenheit with the formula

o Set echo=FALSE so this code runs but fahrenheit = celsius x 3 +32
IS not visible to the reader Cleaning

To analyze this data, we will use the following R packages:

library|nasaweather)
library(tidyverse)



SOLUTION

9. Add code chunk 1 (R packages) Data

The atmos data set resides In the nasaweather package of the A programming language. It
contains a collection of atmospheric variables measured between 1995 and 2000 on a grid of
576 coordinates in the western hemisphere. The data set comes from the 2006 ASA Data Expo.

° Set message:FALSE SO megsages are Some of the variables in the atmos data set are:
nOt prOduced |n yOur repOrt When « temp - The mean monthly air temperature near the surface of the Earth (measured in

degrees kelvin (K))

yO U ‘ O a d th e p a C ka ge S  pressure - The mean monthly air pressure at the surface of the Earth (measured in

millibars (mb))

« pzone - The mean monthly abundance of atmospheric ozone (measured in Dobson units

(DU))

You can convert the temperature unit from Kelvin to Celsius with the formula

“‘{r message = FALSE} celsius = kelvin — 273.15
. And you can convert the result to Fahrenheit with the formula
library(nasaweather)

library(tidyverse)

N\ \

fahrenheit = celsius X ; + 32

Cleaning

To analyze this data, we will use the following R packages:

library|nasaweather)
library(tidyverse)



OLUTION

10. Add code chunk 2 (year being Data

The atmos data set resides in the nasaweather package of the R programming language. It

‘ d contains a collection of atmospheric variables measured between 1995 and 2000 on a grid of
a n a yZ e 576 coordinates in the western hemisphere. The data set comes from the 2006 ASA Data Expo.

Some of the variables in the atmos data set are:

® S et ecC h 0= FA LS E S O th | S C O d e r U n S b U t « temp - The mean monthly air temperature near the surface of the Earth (measured in

degrees kelvin (K))

|S n Ot \/l S| b ‘ e tO th e rea d e I,- « pressure - The mean monthly air pressure at the surface of the Earth (measured in

millibars (mb))

« pzone - The mean monthly abundance of atmospheric ozone (measured in Dobson units

(DU))

You can convert the temperature unit from Kelvin to Celsius with the formula

\\\{r EChO = FALSE} celsius = kelvin — 273.15
ye a r <_ 1 9 9 5 And you can convert the result to Fahrenheit with the formula

SRR fahrenheit = celsius X ; + 32

Cleaning

To analyze this data, we will use the following R packages:

library|nasaweather)
library(tidyverse)



YOUR TURN!

ANG yOou Gan convert tne result 10 ranrenneit witn ineg rarmuia

11. Add an inline code chunk to fabrenhei = celsus x 2 +32
reference the year being analyzed Cleaning
(COde Chun< 3 & 5) To analyze this data, we will use the following R packages:

library(nasaweather)

1 2 * Ad d CO d e C h U n |< 4 a n d m a ke |t \/ | S | b ‘ e For the FEI'T'IE-I-T"IﬂEF I:l'.f'l'hE report, we will look only at data from the }"E aggregate our

tO th e re a d e I" data by location, using the R code below.

means <- atmos %>%
filter(yvear == year) %>%

13. Knit to HT ML, change the year being peeeita{bamp = Sben{sep, sa-ma = Hhee)

pressure = mean(pressure, na.rm = TRUE),

analyzed to 2000 and re-knit riondiow = meea{eloniion, macim = ),

cloudmid = mean(cloudmid, na.rm = TRUE),

document. Note how the inline code cloudhish = mean (cloudhish, na.rm = TRUE)) >4

ungroup( )

C h U n <S C /] a n ge . where the year object Equal




SOLUTION

ANG yOou Gan convert tne result 10 ranrenneit witn ineg rarmuia

11. Add an inline code chunk to fabrenhei = celsus x 2 +32
reference the year being analyzed Cleaning
(COde Chun< 3 & 5) To analyze this data, we will use the following R packages:

library(nasaweather)

library(tidyverse)
For the remainder of the report, we will look only at data from the yegr 2000. \We aggregate our
data by location, using the R code below.

data from the year ryear =2000 ryear mosns < atmos ot

filter({year == year) %>%
group by(long, lat) %>%
summarize(temp = mean(temp, na.rm = TRUE)},
pressure = mean(pressure, na.rm = TRUE),
ozone = mean(ozone, na.rm = TRUE),
cloudlow = mean(cloudlow, na.rm = TRUE),
cloudmid = mean(cloudmid, na.rm = TRUE),
cloudhigh = mean{cloudhigh, na.rm = TRUE)) %>%
ungroup( )

where the year object equalq 2000.



SOLUTION

12 Add code chunk 4 “{r message = FALSE, warning = FALSE}

and make 1t visible means <- atmos %>%
to the reader filter(year == year) %>%

group by(long, lat) %>%

summarize(temp = mean(temp, na.rm = TRUE),
pressure = mean(pressure, na.rm = TRUE),
ozone = mean(ozone, na.rm = TRUE),
cloudlow = mean(cloudlow, na.rm = TRUE),
cloudmid = mean(cloudmid, na.rm = TRUE),
cloudhigh = mean(cloudhigh, na.rm = TRUE)) %>%

ungroup()



SOLUTION

ANG yOou Gan convert tne result 10 ranrenneit witn ineg rarmuia

13.Knit to HTML, change the year being fabrenheis = celius x 2 + 32
analyzed to 2000 and re-knit Cleaning
d O C U ’Y] e r ':. N Ote h OW th e | n | r] e CO d e To analyze this data, we will use the following R packages:
chunks change. e

B S et ok i o e . e

means <= atmos %>%

filter(yvear == year) %>%
group by(long, lat) %>%
summarize(temp = mean(temp, na.rm = TRUE),
pressure = mean({pressure, na.rm = TRUE),
ozone = mean(ozone, na.rm = TRUE),
cloudlow = mean(cloudlow, na.rm = TRUE),
cloudmid = mean(cloudmid, na.rm = TRUE),
cloudhigh = mean{cloudhigh, na.rm = TRUE)) %>%
ungroup( )

where the year object equalq 2000.




YOUR TURN!

Data

The atmos data set resides in the nasaweather package of the A programming language. It contains a collection of atmospheric variables
measured between 1995 and 2000 on a grid of 576 coordinates in the western hemisphere. The data set comes from the 2006 ASA Data Expo.

Some of the variables in the atmos data set are:

« temp - The mean monthly air temperature near the surface of the Earth (measured in degrees kelvin (K))

+ pressure - The mean monthly air pressure at the surface of the Earth (measured in millibars (mb))
e >< a I ' ‘ O e ‘ l | I ' S O a = ozone - The mean monthly abundance of atmospheric ozone (measured in Dobson units (DU)
°
You can convert the temperature unit from Kelvin to Celsius with the formula

celsius = kelvin — 273.15

the plot output Is provided. Set the code e S
chunk options to: Cleaning

To analyze this data, we will use the following R packages:

library(nasaweather)
library(tidyverse)

o e C ‘ ' O —_— = A ‘ S - For the remainder of the report, we will look only at data from the year 2000. We aggregate our data by location, using the / code below.

means <- atmos %>%

filter(year == year) %>%
group by(long, lat) %>%
summarize(temp = mean(temp, na.rm = TRUE),

L4 L4 pressure = mean(pressure, na.rm = TRUE),

. fl g h e | g ht — 4 ozone = mean(oczone, na.rm = TRUE),
° cloudlow = mean(cloudlow, na.rm = TRUE},
cloudmid = mean(cloudmid, na.rm = TRUE},

cloudhigh = mean(cloudhigh, na.rm = TRUE)) %>%
ungroup( )

° ° where the year object equals 2000.
« fig.width =5
[

Ozone and temperature

Is the relationship between czone and temperature useful for understanding fluctuations in ozone? A scatterplot of the variables shows a strong,
but unusual relationship.

. fig.align = ‘center’

300 - -
.
i)
5
M280 -
o
L ]
260 -
- -
.
285 290 285 300



SOLUTION

Data

The atmos data set resides in the nasaweather package of the A programming language. It contains a collection of atmospheric variables
measured between 1995 and 2000 on a grid of 576 coordinates in the western hemisphere. The data set comes from the 2006 ASA Data Expo.

Some of the variables in the atmos data set are:

« temp - The mean monthly air temperature near the surface of the Earth (measured in degrees kelvin (K))

+ pressure - The mean monthly air pressure at the surface of the Earth (measured in millibars (mb))
e >< a I ' ‘ O e ‘ l | I ' S O a e = ozone - The mean monthly abundance of atmospheric ozone (measured in Dobson units (DU)
°
You can convert the temperature unit from Kelvin to Celsius with the formula

celsius = kelvin — 273.15

plot output Is provided. Set the code ChUuNK e
OpthﬂS tO Cleaning

To analyze this data, we will use the following R packages:

— I library(nasaweather)
. | library(tidyverse)

For the remainder of the report, we will look only at data from the year 2000. We aggregate our data by location, using the / code below.

o ':°gqeight = /4 e s

filter(year == year) %>%

group by(long, lat) %>%

° °
_: summarize(temp = mean(temp, na.rm = TRUE),
. \/\/ | —_— pressure = mean|pressure, na.rm = TRUE),
® ozone = mean(ozone, na.rm = TRUE),

cloudlow = mean(cloudlow, na.rm = TRUE},
k] cloudmid = mean(cloudmid, na.rm = TRUE},

- . —_— ( ) cloudhigh = mean(cloudhigh, na.rm = TRUE)) %>%
 Tig.align = ‘center
N\ \ _ ° ° _ ° ° _ ° ° _ 1] 1] where the year object equals 2000.
{r echo = FALSE, fig.height = 4, fig.width =5, fig.align = "center"} Oz0ne and temperature
g g p I Ot ( d a t a p— m e a n S ) a e S ( X p— t e m p ) y p— O z O n e ) ) + Lsutthjnrjslit;f?:;i?;-,:ﬁ:sn ozone and temperature useful for understanding fluctuations in ozone? A scatterplot of the variables shows a strong,
geom_point()

N\ \
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.
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YAML

Relationship Between Ozone & Temperature

15. Add remaining text and code chunk: — =

« Data

« Cleaning

» Ozone and temperature
« Model

16. Change the YAML header to:

Data

The atmos data set resides inthe nasaweather package of the AR programming language. It contains a collection of atmospheric variables
measured between 1995 and 2000 on a grid of 576 coordinates in the western hemisphere. The data set comes from the 2006 ASA Data Expo.

Some of the variables in the |\, 1 e 2. AFIT Data Science Lab R

—_—— Programming Guide | . .
+ temp - The mean MoNuny anr wmporawre nearwesuniaCe of the Earth (measured in degrees kelvin (K))

« pressure - The mean monthly air pressure at the surface of the Earth (measured in millibars (mb))

tlt'@ ”Relatlonshlp Betv\/een Ozone & Temper‘atu re” + ozone - The mean monthly abundance of atmospheric ozone (measured in Dobson units (DU))

You can convert the temperature unit from Kelvin to Celsius with the formula

author: "Justin Jodrey" celsius = elvin — 273.15

d ate - r SyS Dateo ! And you can convert the result to Fahrenheit with the formula

O Utp Ut fahrenheit = celsius X % +32
htm! document: Cleaning

To analyze this data, we will use the fcllnw'lng R pacl-cages:
toc: true

library(nasaweather)
library(tidyverse)

For the remainder of the report, we will look only at data from the year 2000. We aggregate our data by location, using the R code below.

means <- atmos %>%

filter(year == year) %>%

group_ by(long, lat) %>%

summarize(temp = mean(temp, na.rm = TRUE),

pressure = mean|pressure, na.rm = TRUE),

TRUE) ,
cloudlow = mean(cloudlow, na.rm = TRUE),
cloudmid = mean(cloudmid, na.rm = TRUE),
cloudhigh = mean{cloudhigh, na.rm = TRUE)) %>%

OZONE = Mean(ozone, Na.rm

TR O1IEs F



DIFFERENT OUTPUITS

1/.Render as an HIML, PDF, and Word document
18.Change the YAML header to:

title: "Relationship Between Ozone & Temperature”
author: "Justin Jodrey"

date: "'r Sys.Date() "
output: slidy presentation

Default is to generate slides based on 2nd level headings but you can add *** anywhere and it will create a new slide there.



HOW [0O: FORMAT DATA TABLES

e Use the knitr::kable() function to # code chunk example
: : . # What will this code chunk do?
display a table with additional “{r echo = FALSE}
! knitr::kable(
fOrmattl ﬂg airquality[1:10, ],

caption = "What a cool table format!"

N\ \

e | 0ok at documentation for LOTS of
options



HOW [O: CACHE RESULITS

e Use the code chunk option cache = # code chunk example
B . # What will this code chunk do?
TRUE to cache results, meaning save  “{recho = FALSE, cache = TRUE}

data <- read.csv(“some_huge file.csv”)

chunk output for future use data

e VERY handy If code take a long time
and you need to update/change code CAGHE ME OUTSIDE

£
o

e Can use the dependson = ... option to
run different code without reloading a
massive data set

i , |
HOW BOUT DAT?



O O .Rmd files @ Reproducible Research E Dynamic Documents
R M a rkd ow n C h e at S h e e-t An R Markdown (.Rmd) file is a record of At the click of a button, or the type N E=®-  You can choose to export the
vour research. It contains the code that a -3fac-3r"ﬂaﬂc,}f-3J can rerun tne finished report as a hitml, Dl:f,
- y | .
learn more at rmarkdown.rstudio.com scientist needs to reproduce your wark codein an R Markdown file to @ MS Word, ODT, RTF, or
. - @ along with the narration that a reader reproduce your work and export markdown document; or as a
‘¥ Studio needs to understand your work. Lpy— the results as a finished report. 3y Ntmior ndf based slide show.
Interactive Documents
Open a new .Rmd file at File » New File » R Markdown. Write document 3 Knit document to create report 4 Preview Output 5 Publish (opticnal) Turn your report into an interactive
Use the wizard that opens to pre-populate the file with a by editing template Use knit button or render() to knit in IDE window o web or server Shiny document in 4 steps
template ; _ _ . : Vi . Synch publish button : _
S— Openin| Save Spell Findand  Publish show [@ © @ ~[Desktop/R-Markdown-Cheatgheet/report. html J toaccounts at Add runtime: shiny to the
T | ot wm;lil:uw Check Eeplan:e ; I::utl_lur"e Open in Browser.., | & Puplish =Tz « rpubs.com, YAML header.
:.'.“ - e SO File  EdIf  Codu view P Jastiea  Bulld  Dabu bols  Halp : T, k ) w . - .
o Uu =2 £ - _ lm:_ R M k d | = RShidio Connect Call Shiny input functions to embed
= : rw-:_m SV, '-__._ ar own - Reload document input objects.
. 2 RCERIEITRL T RStudio 1 E'Fd - iDE”WE”t Call Shiny render functions to embed
Fom oo § . 5 " wAkm + B Markdow ' N |LE ﬂEIt tl:' 1 )
g S '.?.‘1';“ . {1 B ° output document Feactive-guiput
. 4 output: Goto Run ) . i - F
Rmd structure W L 5 html_document: code ode Examine build lo :end;r with rn:grkgsnxg:. HIJI;IEW click
: .?AITL HtE_H-I‘.lE; 6 toc: TRU cl hu - - un bocumentin 10
ptional section o 7
render (e.g. pandoc) 8 sefputpufifile My ™ -
options written as g' ) {r setup, h"'—h”‘“ y avil alonclde Rmd o B
l-:E';,.':*-.-'EllLJE pairs (YAML). :1 ALEr: Jopts_chunkis output: ht:L__dnv:umEnt 5 -
runtime: shiny -
= At start of file 12 ; o
14 chunk nrevious current “*{r. echo = FALSE}
Text .. 15 This is an R Markdown document. options chunks chunk e speeg dist Use rmarkdown::render() : e 1 4.00 2.00
Narration farmatted with 16 Markdown i5 @ simple formatting n, X #F Mi } 4.0 Min., 1 2.00 to render/knit at cmd line. numericinput{n®, *
markdown, mixed with: i; b?zt:; :U"dﬂztmrmf HTML, PDF, #gTat Qu.:12.0 1lst Qu.: 26.00 Important args: Hoss many £arsi®s 5] 2 4.00 10.00
an ] OUMENTS . r o ian :15. B ; x i L : 3 7 .00
Code chunks .. 19 | S, b 4 :1: :fi:ﬂ :qg :ﬁi;an : jjg: input - file to render renderTable({ ol il Mt
Chunks of embedded ™ 1 i? ﬁum;[.:]r.?;;im ## 3rd Qu.:19.0 3rd Qu.: 56.00 output_format ”head(carg, inputsn) 4 7.00 22.00
code. FE!Ch CI"ILIF'IEL‘ i it #F Max. s 2% .0 Hax. :120. ﬂLItFIJt_’DPﬁﬂHS-LiStEIf B e | a.eil 16 B0
» Begins with " * " {r} 23 | | render options (as in YAML)
« endswith ™77 i‘; For "?FE *_ihﬂ_'fﬂﬂf-kzﬂ using R Mar For more detalls on using R Markdefvn see output_file
R Markdown will run the seE <nctp://rmariiom, res T http://rmarkdown. rstudio.com. o : Embed a Eﬂmplﬂtﬂ dpp intnyﬂur document with
131 CIR Mo r r”‘ £ T = - - shiny::shinyAppDir
Fgﬁdue{éqg ﬁﬁl:épjgg - Coned === e p s B _Mlleckag Helg® femer @ —Y ' %It- &n‘m 1o use y nyapp []
- : W M Foider | §) | Dalate: [ ffname | G More - envir - environment to * Your report will rendered as a Shiny app, which means you
It will use the location of - - - - i . o Y app, ¥o
the Bmd file asthe > [Lararylrmrkdomn) L . Rl evaluate code chunks in must choose an htmi output format, like htmi_document,
oLk . » render("report Rmd”, cutput_file = "report.html"} & reportAmd 3590 B Feb 26, 2016, 3:35 PM . . _ - :
working directory B o . encoding - of input file and serve it with an active R Session.
Embed code with knitr syntax Parameters
- [nline code | | _ Code chunks Global options Parameterize your documents to reuse with
Insert with “r=code="_ Results appear as ext without code. Dp_ ﬁ or m{?’iealrtndeé _E.yrg:[: ESEE ““*{r echo=TRUE} * I Setwith knitr:opts_chunk$set(), e.z. different inputs (e.g., data sets, values, etc.)
: . Wit : .
'?:ﬂzt';:rzrm.mﬂ . * Built with 3.2.3 chunk options within curly getRversion() L """ {r include=FALSE]} Add parameters —
Important chunk options parameters in the e
_ _ + _ ; header as sub-values d: !r Sys.Date()
cache - cache results for future knits dependson - chunk dependencies for fig.align - ‘left, 'right, or 'center’ (default ~ message - display code messages in of params R
{default = FALSE) caching (default = NULL) ='default’) document {default = TRUE) Call
cache.path - directory to save cached echo - Display code in output document fig.cap - figure caption as character results {default="markup") I:all param:f.'ters Today's date
results in (default = “cache/") (default = TRUE) string (default= NULL) ‘asis' - passthrough results V;ﬁf{g?ﬂfﬁ"ag S
child - file(s) to knit and then include engine - code language used in chunk fig.height, fig.width - Dimensions of ,h'de, -donotdisplay results params$<name>
(default = NULL) (default="R" plots in inches hold' - put all results below all code - N
: . - ; e . ; g : . parameLers - g it :
collapse - collapse all outputinto single ~ @rrOr - Display error messages in doc highlight - highlight source code tidy - tidy code for display {default = Set values wth Knlt - i
hlack (default = FAl SE) (TRUE) or stop render when errors occur— [defanlt = TRIIE! FALSE) SELVAIUES WLUITRIIL 1 o ke to mL




R NO EBOOK



WHY 50O SPECIAL?

An R Markdown document that allows for independent and
Interactive execution of code chunks.

1. Creates greater interactivity while creating your document
2. Easy to share your notebook directly

3. When complete, knit to the publication format desired



DEMO

e Open “RMarkdown Demonstration Notebook.nb.html” file.
e Download Rmd.

e Open Rmd in your RStudio, make changes, knit, and send back to your
collaborator.

Relationship Between Ozone & Temperature

Show All Code
Hide All Code

2017-06-27
Data

The atmos data set resides in the nasaweather package of the R programming language. It contains a collection of atmospheric variables
measured between 1995 and 2000 on a grid of 576 coordinates in the western hemisphere. The data set comes from the 2006 ASA Data Expo.

Some of the variables in the atmos data set are:

« temp - The mean monthly air temperature near the surface of the Earth (measured in degrees kelvin (K))
« pressure - The mean monthly air pressure at the surface of the Earth (measured in millibars (mb))
« ozone - The mean monthly abundance of atmospheric ozone (measured in Dobson units (DU))

You can convert the temperature unit from Kelvin to Celsius with the formula

celviue = kelvin — 273 15



WHAT O REMEMBER



WHAT YOU SHOULD KNOW

Topic Description

R project Coovemently organizes files pertaining to specific analytic
projects
Allows user to combine prose, code, and metadata into one
R Markdown . . L . L
file for to increase reproducibility and reporting capabilities
An R Markdown document that allows for independent and
R Notebook . . .
interactive execution of code chunks.







